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Disclaimer: 
This manual is intended to be used for the Axeze Access Control system only. No 
reference should be drawn to any other Axeze product or a third party product. Axeze has 
taken utmost care to provide correct and up to date information about Axeze products and 
related third party products. However, we suggest you contact our local supplier, Axeze or 
visits www.axeze.com.au for updated information. It is the responsibility of the customer to 
test and determine the suitability of this product for specific applications. The customer / 
installer is responsible to make sure that they have latest updated information on Axeze 
products.  
 
In no event shall Axeze Pty Ltd be responsible or liable for any damages incurred by the 
buyer or any third party arising out of the use of inability to use the product. 
 
This manual is protected by copyright laws and should not be copied fully or partially 
without written consent of Axeze management. 
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Introduction 
The Axeze KEN access control system is a multi drop network that enables 32 networks of up to 62 access 
points each to be seamlessly integrated into one system by the Network Management Suite (NMS).  This means 
the product is easy to expand at a later date. 
 
Axeze uses controllers for each access point.  Each controller is able to monitor and store information whilst 
offline. The micro controllers can handle 1,000 offline events, track 1,000 users and maintain different timed 
access permissions.  
 
The system is designed and manufactured in South Australia and is assembled using the latest surface mount 
technology with design features that provide increased reliability and self-diagnosis functions. 
 
This Programming and Installation guide applies to all products in the Axeze access control range. 
 
The NMS Programming guide provides information on the many options available to the installer and step by 
step instructions on how to setup and use the software. 
 
The Installer menu options and the displays for each option have been listed in the sequence in which we believe 
will be the order for you during installation.   
 
The pages in the manual have been designed to make it easy to find specific pages and a softcopy is available at 
www.axeze.com.au under support. 
 
Axeze products are unique in their naming. For instance an Axeze Controller is called a Controller in NMS 
software.  Axeze Antennas are normally known as readers in the Security and Access Control industry. 
 
Note: Axeze bases access on Controllers, rather than areas.  
 
 
 
Axeze contact details:  

Axeze Pty Ltd 
Bowden Railway Station Building 
Station Place 
Hindmarsh  
South Australia 5007  

Phone: +61 8 8340 8200 
Facsimile: +61 8 8340 8211 
Email: bizdev@axeze.com.au  
Web site  www.axeze.com.au  
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The Axeze KEN Hardware Capacity  
• 32 networks per system (Unlimited with Axeze GUI) 
• Up to 62 access points per network (Note: each I/O takes up one access point) 
• Up to 496 Inputs per network 
• Up to 496 Outputs per network 
 

System Requirements for the NMS 
Intel Pentium Pro or Pentium II based personal computer. Microsoft Windows. NMS software has been written to 
run on:  

• Windows(R) 2000  
• Windows(R) XP  
• Windows Vista Home Premium 
 

CD-ROM drive (for installation) 
Disk space required is approximately:  
� 5MB plus space for database and log files 
� 8-bit graphics adaptor and display (for 256 simultaneous colours) 
 
Other recommended items include  

• MS Windows supported sound card.  
• A pointing device or mouse is required to operate all functions of the software.  
• Microsoft Internet Explorer 4.0 or greater  

 
KENCfg software has been designed to configure Axeze Controllers with an ID.  You can purchase the KENCfg 
software by ordering ACS from Axeze.  This product is available for approved Axeze installers only and is not 
available to the general public.   

Products and Product Codes  
  
AXEZE CODE DETAILS 
KEN-OL Range 
   KEN-OL2 Ken Offline Controller - proprietary 
   KEN-OLW2 Ken Offline Controller – for Wiegand Controllers 
   KEN-I-OL2 Ken Offline Controller – Proprietary, for internal installation only 
INTERFACES 
   A-CBI Axeze C-Bus Interface 
   ACI Axeze Comfort Interface 
 Other interfaces available contact Axeze on +61-8-83408200 or tech@axeze.com.au 
AXEZE CONFIGURATION SYSTEM FOR INSTALLERS ONLY  
   ACS Axeze Configuration System for Axeze approved installers only 
   ACS-IQH Axeze Configuration System for IQ Homes installers only 
LIFT CONTROL 
   ALC Axeze Lift control 
NETWORK HARDWARE 
   ANC Axeze (RS-232 to RS-485) Network Converter   
   APR Axeze (USB) Programming Reader  
   AUI Axeze Universal Interface  
   KEN-IO 16 Channel digital input/output board (Note: Outputs respond to events both On line and 

Off  line whereas inputs respond to events in On line mode.) 
   AAA Axeze Antenna Assembly (generally known as a reader) 
   WPA Axeze Waterproof Antenna (generally known as a reader) 
AXEZE TAGS 
   AT-C Axeze Transponder Card  
   AT-KF Axeze Transponder Keyfob  
SOFTWARE 
NMS-AXE Network Management System  
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Tips before you Start 
Every peripheral connected to a network (with the exception of the Converter) requires an ID that is unique to that 
network. It is also important to understand that NMS will not change an ID in any hardware on the network. 
Controllers in the KENMon database must be set to that same ID as the hardware for the two to communicate. 
 
When using a Serial to USB Converter,  Axeze recommends Targus Group International, U232-P9 (Taiwan) 
(other converters operate differently and Axeze cannot guarantee their performance). 
 

Documentation Required  
(Available at www.axeze.com.au /support) 

• Cable Size Calculator.xls  
• Troubleshooting Guide.doc 
 

Data Sheets  
(available at www.axeze.com.au /support)  

• Datasheet ABC-01.pdf 
• Datasheet ANC-02-TB.pdf 
• Datasheet AT-C-01.pdf 
• Datasheet AT-KF-01.pdf 
• Datasheet AUI-01.pdf 
• Datasheet WPA/AAA.pdf 

• Datasheet KEN-IO.pdf 
• Datasheet KEN-OL-DA.pdf 
• Datasheet KEN-OL2.pdf 
• Datasheet KEN-OLW.pdf 
• Datasheet NMS.pdf 

 
Templates  
(available at www.axeze.com.au /support) 

• Axeze repair request 
• Card Inlay location.pdf 
• Group Access planning sheet.pdf 
• Group members planning sheet.pdf 

• Network I/O planning sheet.pdf 
• Network Controller Planning Sheet.pdf 
• WPA Template Rev C.pdf 
• Zone planning sheet.pdf 

 
Wiring Diagrams 
(available at www.axeze.com.au /support) 

• Axeze KEN Wiring Diagram Rev F.pdf 
• KEN with Wiegand Controllers Wiring 

diagram.pdf 
• Lift Control Interface.pdf 

• Wiring a fail safe strike to a Clipsal smoke 
alarm.pdf 

• Wiring a fail secure strike to a Clipsal 
smoke alarm.pdf 

Training 
Regular and ongoing Training of all products within the Axeze range is carried out in South Australia.  There is a 
fee charged for this course, but you take home the same or equivalent value in product, so technically the course 
is free.  To book a training session contact Axeze on +61-8-83408200. 
 

Gainsborough Trilock 
Electric strikes operate with most door latches, however we recommend 15JJ  latch - use any handle to 
suit the 15JJ. 
 

KEN-IO 
Note: Outputs respond to events both Online and Offline whereas inputs respond to events in Online mode. 
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Planning the network System 
1. Plan the layout of the network system 
2. Provide yourself with a chart showing the controllers, their Ids, access etc. (See Installer’s Package for 

Network Planning and IO Planning templates.) 
3. Have a pen and sticky note paper or tape ready to record the ID on the Controller, and record it on your chart 
4. Load the KENCfg files from your Installer Pack (See Configuring Controllers). 
5. Calculate the number of Axeze controllers you require for the job.  If more than 62 access points you will 

require additional hardware. 
 

Getting Started 
Before you start, make sure you have: 
1. PC with one Comm. Port and installed NMS software.  
2. An Axeze Network Converter (ANC).  
3. Hardware that you are going to install and a power supply. 
 

  

Before going to the site 
1. Check that you have a screw driver for the small terminal blocks  
2. Check you have the Network Planning Form  where you planned the Controllers Id’s and location (above). 
3. Take the KENCfg  and Dongle,  which you used to set the Id’s of all Controllers (above). 
4. Check that you have your Group Access Planning Sheet and Group Members Planning Sheets  
5. Configure all Controllers and peripheral hardware 
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Connecting the Network 
 
The Axeze KEN network utilises an RS-485 multi drop network on two wires.  For it to function correctly we would 
suggest to use the procedures outlined in this manual, otherwise a great deal of time could be wasted if this is not 
done.  
 
PC Ports and Converters 
If the host PC has a RS-485 network card built in, the Axeze network can be connected directly to it, however 
most PC’s come equipped with at least one RS232 port.  To use this port you will require a RS232/485 converter. 
Should you require more networks than your PC has spare COMM ports, you can purchase additional 
communication adaptors from any computer accessories supplier. If NMS is to be run on a laptop then special 
attention needs to be given to choosing a USB – Serial Converter. Contact Axeze support staff for the latest 
information on USB adaptors. 

 

Network Cable 
Type 
The units on the network are connected in daisy chain fashion via quality twisted pair cable such as Cat5. The 
cable should be installed in accordance with standard data cabling practices with the emphasis on keeping a 
minimum distance of 200mm from 240-volt cabling. Where the data cable must cross 240 volt cables it should do 
so at right angles.  Shielded cable should be used for segments that pass through known hostile RF 
environments. 
 
Length 
The RS485 standard indicates a maximum cable length of 1200mtrs but this can only be achieved at low data 
rates. As the data rate (baud) increases the useable length decreases. Because the Axeze network transmits 
data at 9600 baud, for reliable network communications it is recommended that you use an RS-485 repeater if 
the cumulative cable length of a network exceeds 1000mtrs. If you require an RS-485 repeater contact your 
Axeze supplier for more information. 
 
Wiring 
On an ideal network, the converter would be the first unit on the network and then all the other units are 
connected in daisy chain style. This is not essential and the converter can be placed in a position other than the 
first unit. In this case it should not be terminated and the network units at each end of the network should have 
the terminating resistors fitted. Each unit has pin A (often labelled “+” for non-inverting input and output) 
connected to pin A on all of the other units including the converter.  Each unit has pin B (often labelled “-” for 
inverting input and output) connected to pin B on all of the other units including the converter. Although not 
essential, Axeze has adopted the standard of using the blue wire for the “A” connection and the blue/white wire 
for the “B” connection. Connect the RS232/485 Converter to a serial port on the host computer. Connect the 
Axeze network to the Converter.  Please refer to the correct wiring diagrams at the end of this document. 
 
Ground connection 
The ground connection on the Axeze units should not be made without first testing potential difference (PD) 
between the grounds. Large currents could flow in this connection if there is a potential difference (PD) between 
the grounds. If a PD of more than 4V exists between the ground connections at different access points then an 
“Isolating repeater” should be used between the two access points irrespective of the number on access points 
on the segment or the cable length. The PD between all access points should be checked on any network that is 
powered from more than one Mains Distribution Box. 

 
Terminating resistors 
The first unit, normally the converter (ANC) and the last unit on the network should be terminated with a 120 ohm 
0.5 watt resistor across the A and B connections.  If a repeater is used a terminating resistor is required on both 
the input and the output of the repeater unless they are built into the repeater.  
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Anti-noise Bias 
The converter pulls  the A line to +5V  via a 1k resistor to +5 volts and the B line down to GND also via a 1k 
resistor. This, in unison with the terminating resistors, places a small bias on the network that prevents small 
interference signals from changing the state of the receiver inputs.  This is known as Anti-noise bias. 
Termination resistors must be fitted otherwise the network will not function correctly.  
 
Power supply 
Each Controller will require a power supply. Choose a supply that will maintain the input voltage to the Axeze 
Reader/Controllers between 10VDC and 16VDC at all times.  (Note: The reader requires about 50mA average 
current and the voltage will be at it’s lowest when the strike is energised).  If more than one Controller shares a 
common power supply, care should be taken in choosing the gauge of the wire used. Calculations should be 
based on the number of strikes likely to be energised at the same time. This could be all strikes if fail safe strikes 
are used. 
 
Some installers recommend putting the strikes and magnetic locks on a separate power supply to the controllers. 
 
Battery backup 
Battery backup should be considered for all installations where continued operation during a power outage is 
required particularly where fail safe strikes are used. An interruption of the power supply will also reset the internal 
clock and consequently off-line logging will not be correctly date and time stamped. The latest controllers (KEN-
OL2) have a supercap backup on their Real Time Clocks (RTCs) and this should keep the time correct for at 
least 24 hours. Also the AUI is battery backed and will broadcast the time after a power failure. 

 

Utilising an existing cable structure 
Due to the cost of running new cables in an existing building it is often desirable to use existing Ethernet cables 
whenever adding services to a building. To allow controllers to connect to an Ethernet LAN, an Ethernet chip 
would be needed at each controller and a larger, faster micro-controller would also be needed increasing the cost 
of the controller significantly. Ethernet to RS-485 converters can be used but can also be very expensive. 
 
However as both Ethernet and Axeze RS-485 recommend the use of CAT5 cable it is possible to re-configure an 
existing network structure to achieve a structured RS-485 network utilising unused Ethernet cable runs. 
 
First find a spare patch panel with a sockets for each Axeze controller and wire all sockets in parallel using 
twisted pairs from a piece of CAT5 cable turning the patch panel into a fully connected distribution unit. Try to 
retain the original twist in the pairs as much as possible for correct operation of the RS-485 network.   
 
Connect the RS-232 port of the Axeze Network Converter to a computer in the server room (which will run the 
KENMon software) and the RS485 port to an unused RJ45 socket of a patch panel creating an RS-485 
distribution point. Then use a patch cable to connect this distribution point to any socket of the newly created hub. 
This will create an RS-485 star network backbone. Now all that is left to do is patch the cable runs to be used for 
the Axeze network to this hub and connect Axeze controllers to the other end and you have a star wired RS-485 
network.  
 
There are many advantages of wiring even a new building this way.  
• It allows for easy expansion of the Axeze network 
• The network is easy to fault find as each network stub can be removed easily 
• By conforming to the structured cabling guidelines the network will be easy to maintain by any qualified data 

cable installer.  
• Each stub off the hub can run 800m 
• Hubs can be cascaded an unlimited number of times 
• It makes an ideal solution for rental sites as tenants can add an Axeze network at little cost then remove all 

Axeze controllers and leave the cable structure as found. 
 
Although this does not adhere to the desired cabling of an RS-485 network, it does work 
in practice due the data rate employed by the Axeze system. The data rate of 9600 
baud is slow enough to guarantee that pulse reflections from the ends of the 
unterminated stubs dissipate long before the next pulse is due to occur. A network 
terminating resistor should be fitted at the converter. 
 



 
 

© Axeze Pty Ltd Version 1.0  
Designed & Manufactured in Australia Updated: 30th March 2009  Page 11 of 55 
 

Testing 
Once you have completed the installation you are ready to start installing the software. We suggest that you first 
check the controllers are all on line and operating.  Note: The LED will flash the Controller’s ID and then turn red. 
 

Configuring the Hardware 

The KENConfig Software 
 
Introduction 
This section of the document describes the configuration of the Controller for Axeze Keyless Entry Network 
System. This version of the software has been written to run on a standard Windows 2000, Windows XP or 
Windows Vista based PC.  

KENConfig is part of the NMS suite of software and it allows you to configure the ID of all components that 
require a network ID (or in the case of the interfaces – NetID). 

 
Connection 
The Axeze KEN software will not run unless plugged into a working Controller.  The Controller is connected to the 
computer via the RS232 port via the Axeze dongle.  It must also be disconnected from any network. 
 
The Controller must be connected to a 12volt DC source. 
 
Installing the KEN CONFIG Software 

1. Load your KENCfg files onto your computer using the 
following steps: 

2. Create an “Axeze” folder on your hard drive; 
3. Copy KENCfg.exe file from your CD (supplied) to the 

“Axeze” folder. The file does not need any further  
Installation. Create a shortcut if required. 
 

Starting the Software 
Once installed you can create a shortcut on your windows 
desktop or run the KENCONFig.exe file from the directory where you installed it.  (As default it installs in 
C:\Program Files\Axeze 
 
Configuring the Controllers 

1. Connecting the Controller to the computer 
2. Remove the cover (enclosure) off the Axeze Controller; 
3. Connect Power (12-16v DC) to the Controller; 
4. Wait  for the LED stop flashing the ID; 
5. Connect USB-Serial Cable to the computer (if needed); 
6. Connect the Dongle (AHL-PC) to the Controller and 

Computer or to the USB-Serial Cable (as appropriate); 
7. If everything is correct the LED will start to blink. 

 
Note: The Dongle must be connected to a powered Controller 
before the software will proceed past the Communication Port Selection window. 
 
Click in the KENConfig icon to start the program. 
 
The software will attempt to open a serial "COM" port and 
establish communication with a KEN Controller via the dongle 
(AHL-PC). If the incorrect port has not been selected or the 
Controller is not connected properly you will be advised that the 
Comm port cannot be opened. 
 
To “Select the Comm Port”.   

a) If you do not know which COMM Port is available, 
Right Click on My Computer, 
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b) Select properties 
c) Select Hardware 
d) Select Device manager 
e) Select Ports 
f) You can now confirm which Port is available on your computer.   
Note: the COMM Port changes from Computer to Computer. 
 

Ensure your program has opened and is displaying the Controller firmware version. 
 

 
 
 
Brief Description of Menu Items 
File: Is used to exit the program 
Controller: Gives the options to retrieve the configuration from the Controller or to send the configure to the 

Controller with the information as shown on the window display 
View: Allows you the opportunity to turn the tool bar and status bars off  
Help:  Contains an About Option. The help about box shows the version of the software and the 

licence details 
 
Controller Properties 
ID - unique identity number for each Controller on the network   
Version - the version of the firmware in the Controller 
Status box -  indicates communications status  
 
Note:  Two Controllers with the same ID must be on different networks for them to communicate with the 
KENMON program. 
 
Configure the Controller by giving it an ID number as per your plan. 
 
Retrieve – Click this ONLY if you wish to retrieve information from the Controller. 
 
 

 
 
 
 
1. Send - You will receive a confirmation dialogue.  
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2. Click on Yes; 
3. You will receive a success message  
 
Error Messages when Configuring Controllers. 
If you do receive an error message 
1. Check that all cables are connected 
2. Check that the power is turned on 
3. Check that the LED is flashing 
4. Check the AHL-PC or AHL-USB is plugged into the Computer and controller 
5. Check the Serial to USB converter is connected (If using AHL-PC) to the USB port 
 
Programming with a USB converter: 
When using a USB Converter you will need to remove the jumpers on two of the Links on the Controller.  
 Link LK2 (TX) 
 Link LK3 (RX) 
 
Note1: DO NOT LOOSE YOUR JUMPERS, as they must be replaced once the Controller is configured. 
Note2: Does not apply to KEN-OL(W)2 as the links are not used on this controller. 
 
When successful continue programming all Controllers with a different ID.   
 
Example of how you might plan a site 
ID 
Number 

Network ID Location to be Installed Programmed by 
 

Access times 

15 1 CEO Office Fred 15th May 7 days a week, all hours 
16 1 Upstairs Store Room Fred 15th May 9-5 specific tag holders 
17 1 This Office  9-5 Mon-Fri (Unlimited access) 
18 2 That office  8-4 Mon-Fri 
19 2 I/O  etc 
 

Sites with more than 62 access points 
If you are planning a site that requires more than one network you will need additional hardware. 
 
32 Networks can be seamlessly integrated into one Axeze system.  Every time you use your 63-access point 
allocation on a single network, and you need more access points you will require an additional network.  In order 
to have an additional network you will require the following: 

• ANC - Axeze Network Converter 
• AUI - Axeze Universal Interface 

 
When setting up a new network go back to “Programming the ID” and configure your second network. 
 
Additional Hardware 
If you do require two or more Networks, Plan them out, allocate their IDs and proceed following the above steps. 
 
Note : the AUI requires its NET-ID to be configured to match the COM Port to which it will be connected. Use 
KENCFG.exe and the AHL-PC to configure the NET-ID.  

(Be warned this may change when you are installing at the site and using their equipment). 
  
You are almost ready to go to the site and start the installation, before you go, please read the Installation 
Guide . 
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Axeze Programming Reader 
 

Do not plug in the APR until the drivers have been loaded as instructed below 
 
Axeze Programming Reader (APR) is a USB device that works as a hardware lock for KENMon.  It controls the 
licence for the KENMon software. 
 
Users need to have an APR plugged in to a USB port of the computer on which KENMon is installed. The 
software will automatically detect the port that it is plugged into.  
 
If the user doesn't have an APR they will have 21 days unrestricted use of the software. After 21 days, KENMon 
will still run but will not communicate over the network, so users will not be able to control any hardware.  
 
When upgrading the KENMon to a higher version (4.x, 5.x, 6.x, etc) your APR has to be returned to Axeze for 
reprogramming.  
 
Should you install upgraded software you will have 21 days to use the new software without the APR, this 
ensures that the customer has full functionality of the software whilst Axeze reprograms their APR. 
 
The APR allows clients to easily add cards/fobs to the system from a central location and acts as a registration 
device.  
 
Every APR is programmed for a specific version of KENMon. APR configuration can be seen in About KENMon 
dialog from Help Screen. 
 
 
Note: APR uses a virtual COMM. Port, Drivers for the USB chip are available at http://www.ftdichip.com 
 

 
Note: If the APR is removed/ loose/not working you will receive following warning message: 
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You will be given 10 days to contact Axeze and get a replacement. After that period, NMS will expire. 
 
 
 

NMS Software Suite 
The KENMon  software forms part of the NMS software suite. 

 
Introduction to NMS software 
This section of the document describes the manner in which to set up the Controllers and the database for the 
Axeze Network System. This version of the software has been written to run on a standard Windows 2000, 
Windows XP or Windows Vista based PC.  

KENMon is part of a suite of software that allows you to manage a database and monitor movement throughout 
the property. 

 
Axeze Programming Reader (APR) 
The NMS-Axe is provided with an APR, which is an Axeze Programming Reader.  The APR is used in lieu of 
software registration allowing it to be moved from PC to PC without requiring relicensing. The APR is used to add 
new cards to the database. 
 
Axeze NMS (KENMon and KENConfig) User Licence Agree ment 
This Axeze End-User Licence Agreement is a legal agreement between Axeze and you or the corporate entity 
for the limited use of the Axeze software indicated above. The software includes computer software or firmware, 
protection ‘dongle’, printed material or other media including on-line documentation. This agreement includes any 
subsequent updates to the original but does not cover any third party software or other Axeze software which 
may be covered by its own licence agreement. If you do not agree with the terms of this licence you may return 
the entire software package to the place of purchase for a full refund. Do not install or use the software. 
Retaining, copying, downloading, executing or using the software in any way will be deemed as being agreement 
by you to comply with all the terms of this licence. 
 
Software Product Licence 
This software is licensed and not sold. International copyright laws protect it. 
 
Except and only to the extent that the following is expressly permitted by applicable law; you may install and use 
a single copy on a single computer regardless of the number of media types supplied or the final format installed.  
� You may make one copy for backup purposes only.  
� Any networked implementation or use on more than one computer must acquire a separate licence for each 

computer.  
� The resulting end-user database files are not bound by this agreement. 
� The software may not be resold, rented, leased, lent, or its value transferred once installed or if rejected.  
� You may not disassemble or otherwise alter nor re-engineer this software.  
� None of the printed or on-line material may be reproduced or circulated without prior written approval from 

Axeze. 
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� Axeze may terminate this agreement, without prejudice to your other rights, if you fail to comply with its terms 
and conditions and may require the return or destruction of the software and all its parts. 

 
Limited Warranty 
Axeze warrants that the software will perform in compliance with the relevant descriptive materials for a period of 
90 days from date of delivery, or to the extent provided by applicable law. Axeze will provide support and 
reasonable efforts to resolve all issues promptly. Liability of Axeze and its distributors to the user shall be at our 
option to replace the product if it is deemed faulty. 
 
To the maximum extent permitted by law, Axeze and its suppliers and distributors shall not in any event be liable 
for any special damages whatsoever arising out of the use or inability to use the software product. 
 
Warranty Disclaimer: 
The software and other information is delivered to you “as is” with all faults.  Axeze and its suppliers and 
certificate authorities do not and cannot warrant the performance or results you may obtain by using the software 
certificate authority services or other third party offerings.  Except to the extent any warranty, condition, 
representation or term cannot or may not be excluded or limited by law applicable to you in your jurisdiction, 
Axeze and its suppliers and certificate authorities make no warranties conditions, representation, or terms 
(express or implied whether by statute, common law, custom, usage or otherwise) as to any matter including 
without limitation noninfringement of third party rights, merchantability, integration, satisfactory quality, or fitness 
for any particular purpose. 
 
By using, copying, or distributing all or any portion of the Axeze software, you accept all the terms and conditions 
of this agreement, including in particular the provisions stated herein before.  Upon acceptance, this agreement is 
enforceable against you and any entity that obtained the software and on whose behalf it is used.  If you do not 
agree, do not use the software. 
 
Axeze permits you to use the software only in accordance with the terms of this agreement.  Use of some third 
party materials included in the software may be subject to other terms and conditions typically found in a separate 
licence agreement, a “read me” file located near such materials or in the “third party software notices and/or 
additional terms and conditions. 
 

Setting up KENMon 
 
Note: Before using the database each area must be set up otherwise the system will not work.  This could lead 
you to mistakenly think the network is faulty.  Please ensure you take the time to read the following information 
and complete all the steps to guarantee a successful installation of the system. 
 
The NMS product range has a software component.  This software component includes the KENMon software. 
 
Start by installing the NMS software and following these simple steps 

1. Ensure the driver for the APR is installed. Then plug in the APR to any available USB port. 
2. Install the NMS software on the client computer. When the option to create shortcuts to KENMon 

appears, un-tick the Desktop and the Quick launch options. You will create a desktop shortcut to the 
database after it has been created and this is the preferred method of starting KENMon. 

3. Run NMS 
4. Go to the Networks Tab and check that the APR is registered. If APR is not connected the software will 

run in trial mode for 21 days will all features available. As soon as the APR is connected for the first time 
it will change to licensed mode. 

5. Double click on the first Network.  Change the COMM port to the appropriate available Comm Port. Use 
the “Port List” tool on KENMon’s tool bar to see what ports are available on the PC. 

6. Click OK. 
7. Configure the KENMon software setting the Options, Defaults and Passwords.  
8. Test all Passwords. 
9. Scan the Networks. All the Controllers attached to the Network should appear in the Controller’s page. 
10. Using your Network Planning Sheet rename the Controllers to more appropriate names, and check that 

all the Door options are correct. 
11. Enroll a Card give it access to all the Controllers. Select “Send Offline Access Controls” from the Tools 

menu to send the card to all Controllers.  
12. Broadcast the time and validate that the time was read correctly by retrieving the time. (Select 

Controllers tab, highlight a Controller and click “Up time” button). 
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13. Check that all Controllers authorise the card and the LED’s, beeper and strike work correctly. 
14. Check the Request to Exit (REX) (if installed), 
15. If a Controller has a door sense switch fitted (and enabled in the Controller Details dialog) open the door 

manually and check the Forced Door and Door Closed events are displayed correctly. 
16. Close the software and check that all Controllers validate the card Offline. 
17. Open the software again and Retrieve the events. Verify that all events that occurred whilst Offline are 

retrieved. 
18. Enroll all cards as required by the client and Send Offline Access Controls to each of the Controllers. 
19. Set up any events if needed and send them to the AUI if one is installed. 
20. Back up the database by selecting the File->Backup Database menu item.   
21. Create a shortcut to the database file and save it on the desktop. Make sure there are no shortcuts to 

KENMon. 
22. Note: If you are missing any documentation you can download it from the Axeze Website, 

www.axeze.com.au under Installers or Support tab. 
 
Removing NMS 
1. Click the Windows Start button, point to Settings, and then click Control Panel.  
2. Double-click the Add/Remove Programs icon.  
3. Click NMS on the Install / Uninstall tab, and then click Add/Remove.  
4. Follow the instructions on the screen.  
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Overview KENMON software and screens 
 

KENMon Main Screen Overview 
 
The diagram below illustrates the main window of KENMon: 
 

 
 
See also brief description of: 
 

• Menu Items  
• Events View  
• Networks View  
• Zone View  
• Controllers View  

• Cards View  
• Groups View  
• I/O Boards View  
• Status Bar  
• Toolbar  

 
Each of the Tabs has windows with similar Menu functionality.  A brief description of these tabs under each 
window is: 
 
Modify: Shows the details of the selected window and allows the user to modify any existing settings. (Note: this 
can also be achieved by double clicking on the network) 
 
New: Enables the user to add additional settings to the database. 
 
Delete: Removes the selected setting from the database. (Remember must be at least one Network on the 
database) 
 
Export Data: Saves the selected data as a tab delimited file "*File.dat" which can be viewed and manipulated in 
Excel. 
 
View Data: Saves the selected data as an HTML file "*File.html" which can be viewed in your web browser. 
 
Right Click  on the mouse, in any screen will provide access to the same menu tabs. 
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Show Serial Ports 
Show Ports dialog shows the serial ports available on the computer running KENMon. This is particularly helpful 
while using virtual serial ports.  
 
The highlighted entry shows the last found port on the computer. If using an USB-to-Serial converter, plug-in the 
device to an USB port and click Refresh to see the virtual COMM. Port mapped to that device.  
 
Clicking Device Manager will open Windows Device Manager Console that will give more detailed information 
about ports and other hardware installed on the computer.  
 

 
 
Alternatively, you can click on the “Show Comm. Ports” icon to get a list of all the available comm. Ports. 
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Backup Database 
 
File/ Backup Database  will create a backup copy of the current database in the folder specified in System 
Settings.  
 
Email Database 
 
File / E-mail Database  will create an email and will attach the current database to it. Default email client 
(Outlook/ Outlook Express) is used to send an email. 

 
 
 
Import Database 
File/ Import Database  can be used to import KES (Keyless Entry Standalone) database. Imported data will be 
added into the current database with the Default Card and Controller settings. 
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Menu Items 
 

 
 
File has submenu of:  

• New database - Create a new KEN database.  
• Open Database - Open existing KEN database.  
• Save Database - Save current database.  
• Save Database As - Save current database with different name.  
• Save Copy As - Save the copy of current database to other location.  
• Backup Database - Backup current database.  
• E-mail Database - Create an email and attach the current database to it.  
• Properties - Display file properties of current database.  
• Import Database - Import KES database to current KEN database  
• Export Database - Export current KEN database to KES database. 
• List of recently used database files.  
• Exit.  

 
View  has submenu of:  

• Toolbar  
• Status Bar.  
 

Tools  has submenu of: 
• Find  allows the user to find particular items in the program.  
• Archive Log  allows the user to archive the log of events.  
• View Log files  allow the user to load previous log files.  
• Events  allow the user to trap internal or eternal events and assign an action to take.  
• Public Holidays  allow the user enter public holidays during the year.  
• Broadcast time  allows users to broadcast the time to all Controllers in the system for offline 

functionality.  
• Broadcast Holidays  allows users to broadcast the holiday dates to all Controllers in the system for 

offline functionality.  
• Send Offline Access Controls  enables the user to send all the access controls for a selected 

Controller for offline functionality.  
• Send Offline Events  enables the user to send the Event controls to the Network Support Module 

(NSM) for offline use.  
• Scan Network  allows the user to scan for all Controllers connected to a network and will automatically 

add all found Controller to the database.  
• Defaults  contain all the default options for the database.  
• Options  contain all the system options for the program.  
• Show Ports  displays the list of available serial ports on the computer.  
• Login  allows the user to login as a different user when passwords are in use.  
• Logout  logs out to basic user level.  
• Hide KENMon  allows the user to hide the application whilst it is still working in the background.  If 

selected this system can still warn the User of important events or problems. Password protection 
enables greater security, as “Unhide” will request a password. 

 
Note: To send Offline Access Controls you will need to be in the Controllers tab section. 

   To send Offline Events you will need to be in the Networks tab section.
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Help has submenu of: 
• Help Contents Help Contents & Index.  
• Tip of the Day shows tips about using KENMon.  
• Contact Axeze to give feedback and report bugs.  
• About KENMon shows the software version and Axeze Programming Reader configuration.  

 
 
Toolbar 
KENMon toolbar contains a set of buttons that you click to carry out common tasks. 
  

 

 

 

 

 
Create  a new Database file. This operation can be also started through File/New DB  menu. 

Open  a Database file. This operation can be also started through File/Open DB...  menu. 

Save the Database file. This operation can be also started through File/Save DB  menu. 

Find  allows the user to find particular items in the program. 

Broadcast Time  allows users to broadcast the time to all controllers in the system for 
offline functionality. This operation can also be performed from Tools menu. 

Send Offline Events  enables the user to send the Event controls to the Axeze 
Universal Interface (AUI) for offline use. This operation can also be performed from 

Send Offline Access Controls  enables the user to transmit all the access controls for 
a selected controller for offline functionality. This operation can also be performed from 

Login  allows the user to login as a different user when passwords are in use. This 
operation can also be performed from Tools menu. 

Show Ports  will display the list of serial ports available on the PC. This operation can 
also be performed from Tools menu. 

Help Contents brings up the help for the program. This operation can also be performed from 
Help menu. 
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Events View 
The Cards Detected window in the Events Tab shows a log of all the activity on the networks. If a response is 
received from a Controller that is not on the database, the logged entry will identify the Controller by the ID of the 
Network and the Controller ID. 
 
The Recent Events window shows a log of all uncleared events the user has requested to be trapped. This list 
can be cleared by double clicking on the text. If the action taken were to set a channel on an I/O device the 
channel would also be cleared by this action. 
 
The page displays: 

• Date,  
• Time the user badged their tag  
• Status - Authorised or Not. 
• Controller attached to the Reader badged 
• Owner of the tag 

 

 
 
 
Auto Archive information is on the right hand side of the application below the time sheet button. This shows the 
date and time that the last auto archive occurred. (The auto archive time can be set by the user in the Tools-
>Options->Logging options page.) 
 
Brief Description of the extra Buttons on the Event s Window  
 
Details: To get details of an Event, either highlight the event and either click details or double click.  
 
Time Sheet: Clicking this button opens an html page showing very similar information as the events window. It 
displays the date, time, the user badged his/her card and from what Controller it was badged. 
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Networks View 
The Network window displays the details of the networks. On initial start up of KENMon there is a default network 
"Network 1" with default Comm. Port of 1. 
 
The Port indicates what COMM Port the network is listening on. 
 
The Status shows whether the network is listening. If the network is not a valid network, then an error dialog is 
displayed and the status shows "Failed to open port." 
 
The description is the title of the network; these can be labelled as the COMM Port numbers as to easily identify 
which network is on what COMM Port. 
 
Brief Description of the extra Buttons on the Netwo rks Window  
 
Work Offline/Online: Enables Offline/Online working of the system. 
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Zones View 
The Zones window shows the name of the Zones as well as the occupancy status of that Zone. 
Zones allow you to Group Controllers into zones allocating entry and exit Controllers so you can monitor 
occupancy of areas and create events based on that occupancy. 
 
Brief Description of the extra Buttons on the Zone Window  
 
Occupancy:  Shows a list of who is currently in the zone.  Note in the event of a full evacuation ie fire, the system 
needs to have all zones cleared. 
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Controllers View 
The Controller window shows which Controller units are online, not responding, and unknown. 
 

• Online  indicates that the Controller is functioning as desired and the LED on the Antenna should be red.  
• Not Responding  indicates that the Controller is Offline and is not communicating on the Network. The 

Antenna LED changes to amber when a card is badged.  After going amber the controller will look up its 
Offline database and either validate or deny the card, in which case the LED will either stay amber to 
turn green. 

• Unknown  is the state of the Controller, when KENMon is first run, prior to being either Online or Not 
Responding. Depending on the number of Controllers on the Network the software may take some time 
to interrogate all Controllers. During this time the status may be unknown.  
 

 
 

 
 
The Description  field identifies the function of the Controller, which the user is monitoring. The Host console is a 
default Controller added to the database upon start up. This Controller's default ID is 1. Note: The Axeze system 
requires at least one Controller on each Network. 
 
Offline Access Controls  shows which Controllers are up to date. 
 
The Hold Lock  Status has three states: 

• Normal - the door has no Hold Lock status and functions as it would normally.  
• Paused - the Close Lock has been clicked and the latch on the door is now locked. The LED will be red.  
• Open - the door is held open for some period i.e. the Controller contains a period of Unlimited Access. 

The Controllers LED will be off.  
 
Brief Description of the extra Buttons on the Contr oller Window  
 
Retrieve Events: retrieves all the stored offline events from the selected Controller, logs them and displays them 
in the events view 
Close lock:  Clicking the close lock button will lock the door of the particular Controller selected and send it into 
Hold Lock status paused. The LED on the Controller will then flash red. 
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Open lock: Clicking the open lock button will open the door of the Controller selected and send it into Hold Lock 
status of either Normal or Open if unlimited access is activated. The controller's LED will then turn green 
indicating that the door is open. 
 
Note: If passwords are activated this button will force you to login before the lock can be opened. 
  
Up Time: Retrieves the time from the selected Controller and displays it.  
To send current time to all the Controllers go to Tools, select Broadcast time. 
 
 
Cards View 
The Cards window displays a list of all the card owners and whether they are Active. 
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Groups View 
The Groups window shows the name of the Group as well as the description of that group. 
 

 
 
 
The Group “Everyone” is automatically included in the system. New groups such as “Cleaners” can be entered 
as desired. 
 
 
 
Input / Output Board View 
The I/O Board window shows the status and Description of I/O boards in the system. The status can be “On line”, 
“Not responding” and “Unknown”. The Description field uniquely identifies each I/O board.  Note: Outputs 
respond to events both On line and Off line whereas inputs respond to events in On line mode. 
 
 

 
 
 
Status Bar  
Status bar on the bottom of the KENMon is used to display the current status of the software 
The status bar in KENMon displays: 
 

• Idle upon it's initial state  
• Receiving from 17  This indicates activity at Controller 17  
• Denied  is displayed when a card badged does not have access to that Controller.  
• Authorised  is displayed when the user has access and the card is valid to the Controller  
• KENMon found Front Door left open  indicates that the door labelled Front Door was left open.  
• KENMon found Front Door forced open  indicates that the door labelled Front Door was forced open.  
• KENMon found Front Door closed  indicates that the door labelled Front Door was closed.  
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Hiding/Showing KENMon 
The user can hide the program using either “Hide KENMon” at System 
Start-up setting or using the Hide KENMon  from Tools menu. When the 
application is hidden the user will not be able to see the program windows 
but all processing will continue in the background. 
 
To indicate that the program is still running an icon is visible in the Windows task bar.  
To show the program again 

• Right click on the Axeze icon and select Show KENMon from the menu, OR 
• Double Click on the Axeze icon 
Note: If passwords are enabled the user will have to enter a correct password before the program will be 
displayed again. 

 
Exit the KENMon 
The User will be asked to Send the Offline Access Controls when any Controller is not up to date as the user 
exits the KENMon system. 
 
 
Network Operations 
This section describes the functions provided by KENMon to transmit data over the network. 

• Broadcast Time; 
• Scan Network; 
• Broadcast Holidays 

• Interface Configuration (AUI) 
• Send Offline Event 
• Send Offline Access Controls 

 
Broadcast time 
To update time in al Controllers on the system 

• Click on Tools  in the Menu Bar 
• Select Broadcast Time   
Note: The time is also broadcast every time the software is started, and when a Controller has been detected 
back Online. 
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Interface Configuration 
NMS Version 4.0 can communicate with Axeze Universal Interface 
(AUI) with firmware version 1.4 onwards, when connected on any KEN 
network. To access AUI configuration:  
 
1. Go to Networks Page.  
2. Select the Network on which, AUI is connected.  
3. Click on Modify button or select Modify from pop-up menu.  
4. If an AUI is connected, the following will be shown in Interface 

window 
• Net ID 
• Firmware version 
• Time 

 
Note: If the AUI does not have the same ID as NETID you will receive 
an error message. 
 
Go back to KENCfg and set the AUI to the correct ID in this case ID “3”. 
 
 
 
 
 
 
 
 
 
 
Scan Network 
Scan Network has been designed to assist you in finding 
errors in the installation of the Axeze system.  (For 
Instance if you have two Controllers with the same ID.) 
 

• Click on Networks tab 
• Click on Tools  in the Menu Bar  
• Select Scan Network   
 

 
 
 
KENMon will update the list of Controllers on a network in the database to what is physically connected to the 
communication line.  
 
KENMon will update the list of I/Os on a network in the database to what is physically connected to the 
communication line. 
 
The settings for each Controller added to the database are set to the Defaults in the Tools->Defaults  
 
Note 1: To use this feature, Networks tab must be currently selected. 
 
Note 2: Scan will use the defaults to set (or reset) the configuration of each controller found during the scan. 
This feature makes it easy to set up networks where many Controllers are connected. 
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Sending Offline Events 

 

 
Each AUI (Axeze User Interface) is capable of storing 100 event controls for Offline event management and 
interfacing to other products. 
 
To send Offline events 

• Click on the Tools  button in the Menu Bar  
• Select Send Offline Events 

 
 
Broadcast Holidays 
Controllers with firmware version KEN 3.00 or higher can handle Holidays Offline.   
 
Holidays need to be sent into each Controller so the system can restrict or allow access on Public Holidays 
correctly Offline. 
 

• Click on the Tools  button in the Menu Bar  
• Select Broadcast Holidays. 

 
KENMon will send the holidays to the Controller memory.  
 
Note: The Controllers LED's will change to yellow whilst communicating with the host. 
 
 
Sending Offline Access Controls 
The access rights need to be sent into each Controller so the system can operate “Offline” (Firmware KEN 
3.00+).  
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• Click on the Tools  button in the Menu Bar  
• Select Send Offline Access Controld   

 
 
Each KEN Controller is capable of 
storing up to 1000 access rights, which 
are used in the event that the computer 
system is down or the system is Offline.  
 

 
To send the Offline Access Controls to a Controller: 

• Go to the Controller view select the desired Controller 
• Click on the Tools  button in the Menu Bar  
• Select Send Offline Access Controls.  
 

KENMon will send the first 1000 access controls assigned to that Controller. 
• The controllers LED's will change to yellow whilst communicating with the host. 
• On completing the sending operation, a summary report will be shown: 

 
View Log shows the send summary for last send. To Retrieve Offline transactions select the desired Controller in 
the Controller page then click on the Retrieve Events button. 
 
 
Note: To disallow access Offline on Public Holidays the Public Holidays need to be sent into the Controllers. 
Note: This is an optimized transmission of Access Controls. Only the changes would be sent. If the controller has 
been replaced, Force Sending Offline Access Controls should be used for the first time. 
 
 
Force Sending Offline Access Controls 
Selecting this option, sends all the Offline Access Controls to the controller, disabling any optimization. It is useful 
when a controller has been replaced. 
 
To Force Send the Offline Access Controls to a Controller: 

• Go to the Controller view select the desired Controller 
• Click on the Tools  button in the Menu Bar  
• Select Force Send Offline Access Controls.  
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Database Operations 
The following steps will guide you in setting up the database with all aspects of the Axeze access control 
system. The whole database can be created prior to installing any hardware with the exception of 
entering cards. 

 
• Creating a New Database File 
• Opening an Existing Database File 
• Saving a Database File 
• Adding a New Network to the Database 
• Adding a New Controller (Axeze Controller) 

to the Database 
• Adding a New Card to the Database 
• Adding a New Group to the Database 
• Adding a New I/O to the Database 
• Adding a New Zone to the Database 
• Adding Public Holidays to the Database 

• Adding an Event Handle 
• Adding a lift control to the Database 
• Sending Offline Access Controls 
• Sending Holidays 
• Sending Offline Event Handlers 
• Find Option 
• Archive Log 
• Auto Archive Log 
• Viewing Log Files 
• Exit the System 
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Creating a New Database File 
 
Using the File/New menu option or selecting the 
shortcut icon of the white page in the Tool Menu will 
open a new database.  
 
It is intended that a new database file be used at each 
site. A database should consist of all the cards, 
Groups, Controllers, I/O boards and networks in use for 
that site. 
 
When the software is started, it will already contain a 
default database. This default database consists of 

• default network Network 1 
• default Controller Host Console  
• Default Groups Everyone .  

 
The network and Controller default values can be 
altered to suite the user using the Modify button. 
However there must be at least a single Controller and 
network in the database for KENMon to operate 
correctly. 
 
The default Group “Everyone” contains all cards and 
cannot be altered.  
 
 
Opening a Database File 
Using the File/Open menu option or selecting the 
recent file from the File  list will open an existing 
database. It is also possible to use the shortcut icon of 
the folder in the tool bar. 
 
To open the database with the program, append the database path and file name to the target entry of the 
shortcut screen. To do this right click on the shortcut icon and select properties. 
 
Note: If you are using only one database, then there is no need to create a shortcut to open the database at start-
up as KENMon will always open the last used file. 
 
 
Saving a Database File 
Saving can be carried out using the File/Save , File/Save As or File/Save Copy As . 
 
Save can be used at any times to save the current database file.  
 
Save As  is used when saving the current database under a new name. KENMon will then begin using the new 
file. 
 
Save Copy As will create a copy of the current database and save it to the location selected by the user. 
KENMon will continue to use the original file and not the newly created one. 
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Adding New Networks 
 

To add a network to the database: 
• Select the Networks Tab  
• Click on New  
• Enter the Comm. Port  that the new 

Network will use. (If an inappropriate 
Comm. Port is entered KENMon will 
display a warning message.) 

• Enter the Description  of the Network 
• The Interface section shows the details 

about the Interface module present on 
the Network 

• Controllers and I/Os section lists all the 
Controllers attached to that Network. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Adding New Zone 
 
To add a Zone to the database: 
• Select the Zones Tab  
• Click on New   
• Allocate a description to the Zone eg. Left 

Wing.  
• Add or Remove Entry Controllers using 

the remove (--->) and add (<---) buttons 
along side the Entry controllers list.  

• Add or Remove Exit Controllers using the 
remove (--->) and add (<---) buttons along 
side the Exit controllers list.  

• Select the Anti-pass back if desired 
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Adding New Controllers (Axeze Controller) 
 
To add a new Controller to the database: 
• Select the Controllers Tab 
• Click on New  

Note: By default every new Controller is 
enabled. You can disable/enable any 
Controller at any time. KENMon will ignore 
disabled Controllers for all the Network 
activities.  
Any changed made in the properties of 
disabled Controller will be saved in the 
database but will NOT be downloaded to the 
Controller.  

• The next available ID for the Controller will 
be presented. (If this is not the ID required 
you may select the desired ID provided it is 
not already in use).  
Note: The ID for the Controller must be set 
prior to this using the KENMon 

• Select the Network created in Adding New 
Networks 

• Allocate a description to the Controller such 
as "Front Door”  

• Set the desired Lock Open Time  
• Check the Sense Door Open check box if 

the user desires a warning to indicate when 
the door is Left Open, Forced, Closed.  
Note for the Door Sense feature to work a 
reed switch must be connected to the Controller. 

• The Warning Delay Option allows the user to set the period of time required before the warning is issued. 
This section also enables the user to set a Warning Beep sounded by the controller to indicate an open door.  

• When the Passback option is selected a time period is placed on the Controller so that upon badging a card 
the user cannot badge again until that time period set has elapsed.  

• Click the Access button to allocate certain access to the Controller.  
• If an error is displayed when OK has been clicked, check the Network of the Controller, and check the 

Controller is Online.  
Alternatively to add all Controllers of a network into a new database you can use the Scan Network  feature 
 

The Lock Open Time  refers to the period of time the electric strike is released 
.  
The Sense Door Open  check box is ticked if the user desires to have a warning to indicate whether the door has 
been left open. This will display a KENMon Front Door Left Open message in the Status Bar. 
 
The Warning Delay  option allows the user to set the period of time required before warning of an open door. 
This section also enables the user to set a warning beep sounded by the controller to indicate an open door.  
 
Passback  is an option for the user to activate when they require a time period placed on the Controller so that 
upon badging a card the user cannot badge again until that time period set has elapsed.  
 
Anti Passback  is an option for the user to activate when they want to ensure that no one can have access until 
an area is cleared. 
 
New or Modify  to define access details 
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Adding Controller Access 
 

To Add Access to a Controller in the database: 
• Open the Controller Access dialog by 

selecting a Controller in the Controller view 
• Click the Modify  button 
• Click the Access button (the Access Control 

List displays all the Users, Groups or 
Unlimited Access allocations for this specific 
Controller "Front Door."  

• Click on the New button to add new access 
to the Controller the Access Control Details 
dialog box will be displayed.  
 
Should the user require a door to be opened 
without the use of a card for a set period i.e. 
from 9 till 5 The Hold Lock Open  feature is 
available.  
The day and time period the user wants the 
door to stay open for is set using the calendar 
and Restricted times.  
Any changes to Hold Lock Open will be 
effective only when Offline Access Controls 
are sent to the controller. 

• Access can be given to particular Groups 
and Individuals  by selecting Group Access 
or Individual Access and choosing the 
Group/Individual required to have access.  
Select the days and times access permitted.  

 

 

Adding New Cards 
To add a new Card to the database 

• Present a card to the APR or any Axeze Antenna on the network (the LED will turn from red to orange). 
• Select the Events page in KENMon 

Note: The Owner of the card is displayed as UNKNOWN.  
 
Troubleshooting:  
If the card entry does not appear in the Events window it means the Network or the controller is not 
functioning.  
o Check all cables are connected and that the power is applied to the controller.  
o Check that the Controller in the KENMon Database is set up on the correct Network and has 

the right ID selected. 
o Check that the Controller is Responding on the Network 
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• Highlight the badged entry “Unknown” and either click on the Details  button or Double Click  
• Assign a name to the card  
• Add a picture of the card user by using the Browse button to search for and select a picture of the user 

stored on your computer.   
Note: The picture profile of the user needs to be saved as a JPEG or GIF file in order for it to be 

displayed. 
• Allocate an expiry date, Date and time. (Note: You will not be able to set access permissions for an 

expired card unless you reactivate it). 
• Click the Access  button and add access to the user.  
• To add the user to a specific Group, click the Groups button.  
• Repeat steps 2 through to 3 for each cardholder you wish to add.  
 
 

Adding Card Access 
• Go to Cards Window 
• Select a card user  
• Click Modify  
• Click Access  
• Use the arrow buttons to select either Individual card or Group Access. 

 

Adding New Groups 
To add a Group to the database  

• Go to Groups Window 
• Click New  
• Enter the name of the Group  
• Enter a description for the Group. You may choose 

to describe the Group as a set of people eg. 
Cleaners, or a set of doors i.e. Kitchen, first floor 
etc. 

• Click Members 
• Allocate members to the group  

 

Adding New I/O Board 
To add an Input/Output Board to the database: 

• Go to I/O boards Window 
• Click New 
• Enter ID of the IO (set using KENCfg) 
• Assign a Network 
• Enter a description of the I/O board eg. Alarms I/O. 

 
Alternatively to add all I/Os of a network into a new database you can use the Scan Network  feature. 
 

Adding Event Handlers 
To add an Event to the database, 

• Click on the Tools button in the 
Menu bar  

• Select Events 
• Click New  
• Input Event Type – use drop down 

arrow 
• Input Event – use drop down arrow 
• Output Event Type – use drop down 

arrow 
• Output Event – use drop down arrow 
• Enter Group Address 
• Enter Ramp Level – if desired 
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• Click OK  

 

Adding Public Holidays 
To add a Public Holiday to the database 

• Click on the Tools button in the Menu bar  
• Select Public Holidays 
• Click  New  
• Enter the date of the holiday 
• Enter a description for the holiday 
• Check if the holiday recurs on the same date each year. 
• Click OK 
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Finding a Card in the Database 
 
To find a Card  Owner  in the Database List,  
Click on the Cards Window 
Click on the binoculars 
Type your search pattern in the Search box.  
Note: Search will Match case, Go Up or Down 
 
 
 
 
 

LOGS AND LOG FILES 
 
 
Archiving the Log 
To Archive the log manually 

• Click Tools  in the Menu Bar  
• Select Archive Log 

 
 
Viewing Old Log Files 
To View old Log Files 

• Click Tools  in the Menu Bar  
• Select View log files   
• Click Browse 
• Select the Log File you wish to view 
• Select Open 
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Sort Log Files 
The user can sort Log Files in any many they wish by clicking on the heading. 

• Date 
• Time 
• Status 
• Controller 
• Owner 

 
At any time a user can see the card details of a log entry by either double clicking the log item from the list. 
 
Auto Archive Log File 
Log Files can be automatically archived in the Options section of the KENMon software. 

• Click Tools  in the Menu Bar  
• Select Option  
• Select Logging Options   
• Select Preferences 
• Select Folder (to store log files) 
• Select Level of logging required 

 
The Archive Preferences can be set for: 

• 12 Hours 
• 24 Hours  

• Daily 
• Weekly 

A set time can be selected for logging to take place 
 
Defaults Settings 

• Card Defaults 
• Controller Defaults 
• Access Defaults 

 
Card Defaults 
To set standard Card Defaults 

• Click Tools  in the Menu Bar 
• Select Defaults   
• Select Card 
• Set up all the Default Values for the 

database 
o Cards do no expire 
o Use default time 
o Use default days 
o Use default year 

• Select Code Display  
o Wiegand 
o Hex 

• Select Card Expiry Notification 
o Send Email 
o Select No of days prior to expiry you wish email to be sent 
o Setup the email address of the person to be notified 

 
Card Expiry Notification  warns the Administrator that cards are about to expire.  
Email  test to ensure all is well 
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Controller Defaults 
To set standard Controller Defaults 

• Click Tools  in the Menu Bar 
• Select Defaults   
• Select Controller 
• Set up all the Default Values for the database 

o Use first Available ID 
o Network 

• Lock Defaults 
o Lock Open Time 
o Sense Door Open 
o Follow the prompts 

• Open Door Monitoring 
o Warning delay (minutes) 
o Warning Beep 

• Passback Defaults 
o Prevent Passback 
o Enter Time for prevention 

• Lift Property 
o Floor Select Period (NMS-LC is required for Lift Access) 
 
 

Access Defaults 
To setup the standard access defaults in the database 

• Click Tools  in the Menu Bar 
• Select Defaults  
• Select Access  
• Check Controller access days (including weekends and public holidays if desired) 
• Restrict times (if desired) 

 
Option Settings 

• System Settings 
• Logging Settings 
• Password Option 
• Lift Settings 
• TCP Settings 

 
System Settings 
To set System Settings 

• Click Tools  in the Menu Bar 
• Select Options 
• Select System 
• Check automatic save 
• Select Maximum No of Entries required in Used Files List 
• Check Use RTS for TX/RX Toggle 
• Select check box required for Display 

o Hide program at start-up 
o Use Pop up warnings when displayed 
o Use Pop up warnings when hidden 
o Display Card owner image when a card is validated 

• Select Folder to store backup 
• Select Work Offline 

o Disable work offline feature 
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Logging Settings 
To set Logging Options 

• Click Tools  in the Menu Bar 
• Select Logging Options 
• Select Auto Archiving Period 
• Check if Archive Time Sheets is required 
• Set time for Auto Archiving 
• Select Folder for Logs to be stored 
• Select Level of logging required 
 

Archiving files are saved in the following format eg. 15_March2002(1).log and then next archive would be 
15_March2002(2).log. Time Sheets are saved in a similar format eg. TimeSheet15_Mar_2002(1).HTML. These 
are HTML pages. 
 
There are two options in logging the occurrences of KENMon. These are: 

• Full Logging  - Contains extra logging information if the user requires it. 
• Normal Logging  - Contains the normal loggings of the Monitoring system. 
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Wiegand Settings 
This option allows user to restrict up to 3 Wiegand site codes so that proximity cards/fobs with restricted site 
codes are denied the access.  

• Click Tools  in the Menu Bar 
• Click on Wiegand 
• Check Restrict Site Codes 
 

 
 
 
 
 
TCP/IP Settings 
The user can monitor and manipulate the 
KENMon database remotely using TCP Interface.  
 
Once Enable TCP Interface so that KENMon will open a TCP/IP comport on port 8023 the next time the program 
is started.  

• Click Tools  in the Menu Bar 
• Select TCP/IP 
• Tick the Restrict IP – for a particular computer to connect to KENMon 
• Type the IP Address  
• Tick the commands Groups to restrict the level of commands remote users can send  

 
Note 1: Controller (Controller) commands are open lock and close lock commands 
 
Note 2: You can restrict computers and restrict commands when using TCP/IP 
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Lifts (NMS-LC only) 
The lift feature has been made as automated as 
possible to simplify setting it up. It is a low level 
integration and therefore uses the KEN-IO boards 
(I/Os) for input from the visitor buttons (one input 
for each floor) and the relay outputs (one relay per 
floor per lift) to advise the main lift controller what 
floor buttons to enable.   
 

• First set the number of floors in 
Tools/Options  

• Click on the Generate Floors. At this time 
you can select a floor and rename it as 
required by clicking on the “Edit” button.  

• Set the “Delay Period” which is the time 
between pressing the visitor access 
button (e.g. opening the lift lobby door) 
and enabling the floor buttons.  This delay 
gives the visitor time to get into the lift.  

• Now set the “Set Period” which is the time 
available for the visitor to press the floor 
button.  
 

 
 

Only the floor button for the floor from which the visitor access button was pressed will be enabled and this period 
should be keep as short as is practical to help prevent persons without valid rights to access the floor from 
selecting the floor.  
 

• Next exit the options menu and go to 
the “Controllers” page. Here you create 
a new controller (one for each lift) 
ensuring you select “Lift Controller” 
each time. 

• Ensure the enable box is ticked.  
• Ensure the ID is unique and the 

controller is set to the correct ID
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• As each new lift controller is created, 

new I/Os will be added to the 
database with descriptions created 
from the lift controller’s description 
and the I/Os associated with the lift 
controller. 

• If the lift has to service 6 floors for 
example one I/O would be required 
and in our example it would be 
named “Goods Lift- 1”.   

• The input channel descriptions of the 
IOs are created from the floor names 
created earlier.   

• The output channels descriptions are 
created from the I/O Channel 
number.  

 
In this example only six inputs and six 
outputs on the I/O will be used.  
 
 
When less than 8 channels are used on an 
I/O, the I/O channel assigned to a floor can 
be changed to an unused channel on the 
same I/O by clicking on “Modify” in I/O Board 
Details.  This could be useful if an output 
stopped working for some reason.  
 
 
 
 
 
 
 
Card access: 
When adding cards ensure users have access to the 
floors they are authorised to enter.  
 
After making a card valid by entering an expiry date 
in the future or by ticking the “Does not expire” box, 
click on the “Lift Access” button to display the “Card 
Lift Access” window and give the card lift access by 
“moving” the floors from the “Floor List” to the “Floor 
Access” list using the < or << buttons.  
 
Reverse the process to remove access to a floor. 
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Password Protection 
In order to prevent unauthorised changes to the database, KENMon is password protected. 
KENMon has three levels of password protection.  
 
Level 1  

Administrator and Service Manager: 
The administrators have full access to the database. They can add cards remove cards, and manipulate 
all data. The administrators can also add Public Holidays and access to the Tools Options. 
 

Level 2  
Assistant: 
The assistant can manipulate all data in the database however they have restricted access to the Tools 
Options. 
 

Level 3  
Monitor: 
The monitor is the lowest level of Password Protection. The monitor can only monitor the database.  
 
Once a password is set you will be asked for the Password every time you open a database that has 
password protection. If the database does not have passwords selected then the default user is 
"Default." 
 

 
Setting up Passwords 
To set up Passwords 

• Click on Tools  in the Menu Bar  
• Select Options.  
• Select Password Setup 
• Check “Use Password Protection” 
• Select Administrator from the User drop 

down arrow (Note: You must enter an 
administrator password first). 

• Type a password in New Password  
(Note: Passwords must be between 4 
to 8 characters long.) 

• Confirm New Password  
• Click Apply   
• Continue setting all other levels of 

password required 
You will receive Confirmation password 
has been saved 

• When finished - Click OK  
 
 
 
You must login as the user you wish to be for your level of password protection to be active.  
 
Also once passwords are active, Opening the lock using the Open Lock button requires a password to be 
entered. 
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Logging on as a User 
When Passwords are in use and a User wishes to Log on as a Specific User  

• Click on Tools  in the Menu Bar  
• Select Login . 

 
Note 1: The Log In dialog will appear if Passwords are activated.  
Note 2: When a user clicks the Open Lock command the Log In dialog will appear. 
 

• Enter your username and password  
• Click OK. 
 
Note1: The database title bar will display the title of the database, followed by the username that you are 
currently logged in as. This will allow you to manipulate the database according to your access. 
 
Note 2: If your login is incorrect  an error message will be displayed saying incorrect username/password. 
Clicking cancel will only allow you to view the database as a monitor (unable to make any changes). 
 
Note 3: If Passwords are not in use, a message will appear confirming this. 

 
Logging out a User 
If passwords are in use and a user wishes to log out,  

• Click on Tools  in the Menu Bar  
• Select Logout . 

 
Monitor level access will be enabled, 
 
Changing Passwords 

• Click on Tools  in the Menu Bar  
• Select Options. 
• Click on Passwords  
• Select the user you wish to change the password for. 
• Type in the current or old password 
• Enter the new password in the New Password   
• Confirm New Password  
• Apply . 

 
If the confirmation of the password is incorrect a dialog will be displayed informing you of this error. You will be 
returned back to the main screen without the alteration being made. 
 
 
Forgotten Passwords 
Both the Administrator and Service Manager can change any password using their own passwords. 
 
If Administrator forgets their password,  

• Contact the Service Manager who can issue the Administrator with a new password using their own 
password. 

 
If the Service Manager forgets their password (at the same time) 

• e-mail your database to software@axeze.com.au  
• Axeze will issue you with a new password.  

 

Trouble Shooting hints and FAQ  
 
These can be found at www.axeze.com.au 
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Other Products 
 

Time Management Software (TMS) 
 
Overview: 
Designed to replace the old time clock systems the Keyless Entry Network works in conjunction with the Axeze 
access control system reducing management of multiple systems and eliminating the problem of employees 
forgetting to clock on or off and clocking off friends. KEN-TMS works in conjunction with the Network Monitoring 
Program KENMon so there is no need for a separate clocking station. Employees can clock on or off at any 
access point monitored by the Axeze Network monitoring program. KEN-TMS gathers the information needed 
from multiple logs generated by KENMon and collates, calculates and sorts this information it into a readable 
format to be used as employee time sheets.  KEN-TMS allows tracking of arrivals and departures, hours worked, 
and overtime (OH&S issues).  The system reports early and late arrivals and is capable of handling extensive 
and complex rolling shift structures. 
 
Features: 

• Absent days 
• Flags early and late starts 
• Hours worked overtime 
• Shifts and shift rotations (including overnight) 
• Selectable reporting periods 
• Creates reports for Groups, departments, and individuals 
• Networked for central reporting 
• Breaks 
• Roster print outs 
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Graphic User Interface (KEN-GUI)  
 
Overview: 
A Graphic User Interface is a powerful 
tool that allows remote management of 
multiple Axeze Monitoring programs 
through a TCP/IP Interface to handle 
more complex sites. Operators use a 
simple graphical interface to monitor 
the status of access points and can see 
any network events which occur at a 
remote location through a LAN or even 
the Internet. The KEN-GUI also allows 
technical or monitoring staff to remotely 
manipulate an access control database 
or even remotely unlock doors. This is 
all done via the security of a 128-bit 
challenge/response password 
protection. 
 
With the KEN-GUI system designers 
can implement complex systems such 
as nation wide sites or tenant control 
without compromising the security of 
each tenant. In tenant systems each 
tenant of a building could run and 
manage their own Access Control 
System using a copy of the Network 
Monitoring Program KENMon. All 
these sub systems would be totally 
independent of each other so there 
would be no issue of other tenants 
having access to your section of the 
building unless you authorise it.  In this system if one area is having problems it will not affect anyone else. You 
could even have an access control system to monitor common areas.   Managers or receptionists can connect to 
the common area system and add cards from their system to the common area, and building managers and 
maintenance staff can issue visitor cards to any tenant areas for visitors or trade people. Communication 
between each system can be protected by a challenge response password system, which would be different for 
each tenant.  
 
Features 

• Remote Database management 
• Remote System Monitoring 
• Remote Opening of doors 
• Remote Closing of doors 
• Remote Management of multiple remote sites 
• Easy to use graphical representation of sites 
• Graphical maps of sites and where controllers are located 
• 128bit encrypted password protection 
• Inter-connectivity of large sites (over 1984 access points) 
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KES Standalone Systems  
 
Overview:  
Axeze’s Keyless Entry Stand-alone system is quite simply the most convenient and secure way to unlock 
anything. Just hold a special, uniquely coded transponder close to the reader and if the transponder is enrolled in 
the system the lock unlocks automatically. 
 
Each Unit can provide access to up to 1000 people and operates completely stand-alone. The Axeze Keyless 
Entry System is suitable for use on doors cabinets, cars, draws, fridges, anywhere where an electric lock can be 
fitted and ideal for the elderly or people with a disability. 
 
Security will never be a concern again as every transponder has its own unique identification code that can not 
be copied or reproduced. Lost or stolen cards can easily be removed out of the system and new transponders 
can be added using either a Master Programming Card or optional computer software. You will never have to 
change any locks or reissue keys again.  
 
Features: 

• Master Programming Card to add and delate tags 
• Software available to manage a database 
• Powerful 1000 users per system 
• One tag all sites 
• DIY or professional installation 
• Interface to other products (i.e. fire alarm, security alarm, home automation) 

 
 
OPTIONS 
 
KES-I-Cash Drawer   
This is a standard KES-I reader/controller with cables designed to connect to a standard 12v cash drawer. Lock 
open time is set to 0, and a Master Programming card is supplied. 
 
KES-IB I Button Controller 
The KES-IB is a variation of the KES-I Reader/Controller that outputs a 1-wire (I Button) compatible data stream 
allowing systems designed for an I-Button input to be upgraded to proximity. 
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Keyless Entry Management Software (KEMS) 
 
Overview: 
The KEMS software package was designed for easy adding of the Master Programming Card (MPC) and so 
clients with large databases can manage those databases. 
 
Clients can program the length of time a door remains 
open, and set passwords to protect their information. 
 
The KEMS consists of the KEMS software and Axeze 
hardware lock (AHL-PC) known as a dongle, with 
software manuals on the CD.  
 
Features: 

• Automatic tag enrolment 
• Enable Sense Door Open  
• View or send version number 
• View total number of tags issued  
• Extensive help screens for using the software 

or installing the product. 

 

Prox Card Log-on Products  
 
 

Overview 
Axeze produce a range of Prox Card readers that can be used for a 
variety of tasks including fast log-on to Point of Sales machines. 
Their use in this role enables tighter stock control and engenders 
greater staff responsibilities.  In many cases these systems pay for 
themselves in weeks and in some cases days. KEP readers 
replace older technologies such as Magnetic Stripe readers and 
Bar Code readers. They operate in conjunction with Axeze tags 
and have no moving parts resulting in extremely long lifetimes.  On 
the other hand magnetic stripe readers and cards both have a 
relatively short life span. The KEP reader achieves its functionality 
by being able to identify a transponder (tag) presented to it, and 
sending the tag’s unique code to another device/host.  The host 
then takes appropriate action such as validating the user, based on 
the rights granted to the holder of that tag. These rights could be 
access to a cash register, recording data, time or any other task 
where controls are required.   
 

Available formats 
There is a variety of hardware and firmware formats available for the KEP.  
 
The output stream can be provided in ASCII or binary format, TTL, RS232, USB or Keyboard Scan Codes (PS2).   
 
The “MiniKEP” has an 80 x 40mm case. The “-M” suffix in the product codes indicates it is a member of the 
MiniKEP family.  The MiniKEP has been designed to mount on the side of terminal equipment using the strip of 
high performance mounting tape bundled the reader. The communication interfaces available include PS2, USB, 
Inverted TTL and RS232. 
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Glossary 
Access The condition of an area or building when it is occupied and when the access control system has been 
set so that normal activity does not set off an alarm. 
 
Access Control  The control of entry to, or exit from a specific area. 
 
Access point Combination of 1 Axeze reader and controller used to operate a door / gate / lift?  
 
Access Rights  Access Rights are access permissions provided to the holder of a credential to proceed through 
an access point. If they are time based then the controller will only grant access if the current time is 
encompassed in the time restriction on the credential. The Controllers can handle 1000 time based access rights 
offline. 
 
Antenna This is a coil of wire used to create the RF field that energises the transponders placed in the field and 
also used to pick up the signals from the transponders feeding them back to the receiver circuits in the reader. It 
can be internal to the reader assembly or external to the reader assembly. External antenna assemblies have a 
Tri-colour LED-indicating device and may have a sounder. 
 
Area A section of a building, which has a specific access control requirement.  Axeze does not provide this 
functionality.  (Other systems allow a building to be divided into as many areas of differing access control 
requirements as needed.  Each area is identified by a name.)   
 
AUI Axeze Universal Interface - A network support module that has a real-time clock on it with a battery backup 
system to maintain correct time on KEN Controller while the system is offline.  
 
Card A card refers to the card form of transponder. 
 
Controllers  Axeze controllers are referred to as Controllers in the NMS software. 
 
Cursor  A flashing character on a display monitor that indicates where the next character entered on the 
keyboard will appear. 
 
Dongle  Axeze Hardware Lock (AHL-PC) that is used by the installer to program a KEN controller using KENCfg 
software.  
 
Event  an Event is a condition for which a handler has been created in the NMS system. The Event handler 
instructs NMS (on-line) and AUI (off-line) what to do in the case of the event occurring.  
 
Fob A fob refers to the key fob form of transponder. It has a hole to facilitate placing on a key ring. 
 
Group  A Group is created when a number of users require the same access rights and grouping them can make 
the process more efficient. Access rights can then be based on the Group instead of all the individual users in the 
group. 
 
Input  A (5-60v) DC signal from any device (Input Device) to the Axeze system. The name of the I/O board (up to 
29 characters) and the name of the channel (up to 15 characters) identify each Input. If the Input is generated by 
installing a lift Controller the channel name is automatically created utilising the floor number. 
 
Jumper  Shorting header which closes the circuit between the two header pins to make a link. 
 
Output  An output is a relay closure – normally open and normally closed contacts (30V 1Amp max). 
The output is identified by the name of the I/O Board (up to 29 characters) and the Channel Number (1-8). 
 
LED Light Emitting Diode. There are two types used in the Axeze systems. A Red LED is used to indicate power 
and a Tricolour LED that can be red, yellow or green, is used to indicate status. 
 
Reader Antenna portion of the Axeze Controller. 
 
Network A number of KEN Controllers connected to a particular COMM Port is said to be on the same network. 
Every network has a network converter (ANC) and may have an Axeze Universal Interface (AUI). 
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NMS Network Management Software used to configure, manage and monitor KEN network. 
 
Occupancy Shows whether a zone is occupied or not and provides a list of people present in the zone. 
 
Offline Access Controls  Offline Access Controls are user access rights that are copied to the KEN Controller 
enabling the Controller to work offline. 
 
Poll an Inquiry message continually sent within the Axeze system ensuring Controllers are communicating with 
the NMS. 
 
Timesheet  A PDF report comprising of the tag names, time in, time out, authorised or unauthorised, and the 
Controller name. 
 
Tag another  name for a credential eg. card, fob, disk etc. 
 
Transponder  Another name for Tag. 
 
Retrieve Events Transfers events stored offline in the Controller to NMS 
 
Up time Clicking this button will retrieve the current time set in the selected Controller. If the RTC has been reset 
due to a prolonged power failure an invalid Hour, Minute, Day and Month will be displayed. The year will not be 
reset. 
 
Version Number  
A version number is the number that identifies the specific release and revision of Axeze software products. The 
version number is composed of 3 parts separated by periods and may include alpha characters.  

• The alpha characters define the family name.  
• The first number is the major version number. 
• The next two numbers (after the period) are the minor version number. 
• The alpha character is the patch level 

 
Zones Area restricted by entry and exit KEN Controllers. 
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